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MOTTO 

 

“Allah (Alone) is Sufficient for us, and He is the Best Disposer of Affairs (for us).” 

-Quran Al „Imraan 3:171 

 

“And be moderate (or show no arrogance) in your walking, and lower your voice.” 

-The Quran Luqman 31:19″ 

 

“A bad attitude spoils a good deed just as vinegar spoils honey” 

-Muhammad SAW 

 

“At the end of the storm, there‟s a golden sky” 

-Bill Shankly 
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Minimization of Material Handling Cost in Fuzzy Environment 

 

By 

Bintoro Wisnuputro 
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Degree of Sarjana Teknik Industri Universitas Islam Indonesia. 

ABSTRACT 

Material Handling Cost is one of most important thing to be considered in designing the 

facility layout. The challenge is to create optimal layout or improve the initial layout. 

This study will proposed a fuzzy mamdani model approach to obtain the Crisp Activity 

Relationship Chart (CARC) that will be used to develop layout using CORELAP, one of 

algorithm technique in designing the facility layout. Then the final CORELAP layout will 

be maximized using Computerized Relative Allocation for Facilities Technique (CRAFT). 

The result of this study showed that the fuzzy approach could be an alternative in more 

precise quantitative analysis. Hence, resulted more minimum material handling cost. 

 

Keywords: Facility Layout, Fuzzy Logic, Mamdani Model, CARC, CORELAP, CRAFT, 

Material Handling Cost 
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CHAPTER I 

INTRODUCTION 

1.1 Background 

Facility layout planning is very important in determine the location and layout. The 

application of facility layout planning can be found in many places, from offices to 

manufacturing. Especially for manufacturing, facility layout planning will be an 

important issue because if the layout placed correctly, so the manufacturing system will 

be optimal. Moreover, layout has important role in material handling. Sule (1994) 

mentioned that material handling itself can account for 30-75% of the total cost. No other 

things that give more effect for the operational cost but the material handling. The further 

impact, the manufacturer can reduce the cost, gain the optimal production, reduce the 

selling price and survive in competitive market.  

 Many researches about facility layout design have been done. One of them 

proposed by Raoot and Rakshit (1993), using linguistic pattern for multiple criteria 

facility layout. The problem-solving methodology illustrated with numerical example and 

directions to select facility layout from the set of alternatives. Activity relationship chart 

(ARC) is the main considering factor to determine the location and design, beside the 

space requirements of each location. Further, fuzzy decision-making system was 

 



2 
 

proposed by Dweiri (1999) to determine the ARC. The object of the research is to change 

the traditional ARC into crisp activity relationship chart (CARC). CARC is obtained from 

fuzzy set approach and it is resulting more precise closeness rating rather than traditional 

ARC. The CARC further can be used to develop the layout using some technique such as 

CORELAP, ALDEP, etc. Deb and Bhattacharyya (2005) develop facility layout that 

minimize flow cost, dead space and area required for the development of layout, using 

fuzzy decision support system. The layout developed using multifactor-normalized 

selection routine.  

 Problem that usually found in determining the facility and location is the closeness 

rating in ARC. Where it is determined by subjective qualitative analysis of the designer 

based on designer‟s knowledge which is A, E, I, O, U, X as the output. If the design was 

considered by subjective, the final layout will not optimal yet, and the cost of the material 

handling will be also high. 

 Hence, in order to minimize the material handling cost, a new method is needed to 

change the closeness rating in ARC that subjective into more objective value. The 

objective value can be derived by calculating a crisp number. One of the method that can 

be used to obtained crisp number is fuzzy approach and resulted CARC. Then, the CARC 

can be used as considering factor in developing a new layout using CORELAP, ALDEP, 

etc.      
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1.2 Problem Formulation 

Based on the background above, the main problem of this research can be formulated as 

follows: 

a. How to change ARC into more objective CARC based on fuzzy approaches? 

b. What is the optimal layout based on the most minimum material handling 

cost? 

1.3 Problem Limitation 

The limitations in this research are: 

a. The research object is focused on PT Fumira, in the production department. 

b. The layouts that will change are the areas in finishing line department that 

possible to be moved and some areas have fixed position. 

c. The factors that will affect the layout are predetermined. 

d. The cost of material handling is predetermined and will not change along 

examined period. 

1.4 Research Objective 

The purposes of this research are: 

a. To develop the optimal layout based on CARC. 

b. To create optimal layout based on most minimum material handling cost.  

1.5 Research Benefits 
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The benefits of this research can be described as follows: 

a. Provide alternatives approach for designer to determine the ARC, not just 

from qualitative but also quantitative. 

b. The fuzzy model can also used in wider area, for example in determining the 

CARC for machines, building, offices layout, determining material handling 

equipment selection, etc. 

c. The fuzzy decision-making system can be adapted to many applications other 

than in facility layout problem. 

d. Able to combine the science knowledge with sense of the art. 

1.6 Thesis Structure 

The thesis structures are: 

CHAPTER II  LITERATURE REVIEW 

This chapter includes the explanation of the previous researches 

that have been conducted at an earlier time about the thesis that is 

composed by the writer and also it provides the literature study that 

the writer is using in the process of composing the thesis. 

CHAPTER III RESEARH METHODOLOGY 

This chapter provides explanations that consist of the object of the 

research, building a model requirement of the data, which is 
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required in completing the research which is divided into primary 

data and secondary data. The method of data collecting that 

involves field research, both direct observation and interview, tool 

of analysis data, framework of research methodology.   

 

CHAPTER IV DATA COLLECTION AND PROCESSING 

This chapter presents information of data that have been collected 

during the research. It also contains the problem solving using the 

proposed model or tools that are implemented in processing the 

data, as well the analysis of the processed data using the proposed 

model or tools.   

CHAPTER V  DISCUSSION 

This chapter provides a discussion about the data that has been 

collected during the research and also the result of processed data. 

Furthermore, it also discuss about the result in order to see whether 

the proposed model or tools are able to solve the problems that are 

formulated at an earlier time of the research. 
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CHAPTER VI CONCLUSION AND RECOMMENDATIONS 

This chapter presents about the conclusions of the research that 

conducted and recomendation of the further research.  

REFERENCES 

APPENDICES 

   a. Table  

   b. Figure  
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CHAPTER II 

LITERATURE REVIEW 

2.1 Previous Research 

Many researchers have concerning to the facilities layout issues. Due to the complex and 

unstructured nature of facility layout, Deb and Bhattacharyya (2004) mentioned that 

many researchers have proposed various approaches, which had varying degrees of 

success in dealing with the complexities associated with the problem. 

 Karwowskij and Evans (1987) illustrated the potential application of fuzzy set 

theory to various areas of production management. The heuristic utilizes two distinct 

design categories which are closeness and importance and expressed using fuzzy 

relations. One of the well-known areas identified by the authors was facility planning 

which includes such problem as facilities layout design. Raoot and Rakshit (1993) have 

also presented a framework of an algorithm for the development and evaluation of a 

layout based on fuzzy linguistic variables and their fuzzy relation. 

 Further, a fuzzy decision-making application for developing relationship charts 

and comparing the layouts generated with them were proposed by Dweiri (1999), which 

suggested further research work to improve the procedure or developing a new algorithm 

for the facility layout design. The facility layout problems fall in to the class of NP-

complete solutions, and heuristic approaches are usually adopted to develop the layout 
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(Heragu and Kusiak, 1990). Most of the models and algorithms available in the literature 

are based on the quadratic assignment problem with an objective to minimize 

transportation costs or maximize total closeness rating. The facility selection routine 

required for the development of layout was solved by considering a single quantitative 

factor as flow chart. Moreover, the move (distance) traversed is considered from center to 

center of the departments without considering the practical issue of entry and exit of the 

departments (Deb and Bhattacharyya, 2005). 

 In their proposed research, Deb and Bhattacharrya (2005) continued the previous 

research using the same direction that proposed by Dweiri (1999). With the objective to 

minimize the area of layout and dead space, the result was that the required area of the 

layout and dead space of the layout are lower by using multifactor fuzzy method, but the 

flow cost was slightly higher.   

 Since the previous research not concern about the minimization of the flow cost 

yet, this paper will develop the research that could minimize the flow cost of the facilities 

that developed by fuzzy method. The minimal flow cost will be obtained from optimal 

layout that developed from the initial layout. 

 

 

 

 

 



9 
 

2.2 Basic Theory 

2.2.1 Facility Design 

Facilities can be broadly defines as buildings where people, material, and machines come 

together for a stated purpose—typically to make a tangible product or provide a service. 

Due to various internal and external forces, the facility must be properly managed to 

achieve its stated purpose while satisfying several objectives. Such objectives include 

producing a product or providing a service at lower cost, at higher quality, or using the 

least amount of natural resources. To manage facilities so that the objectives (which often 

conflict with one another) are attained, one must understand the underlying decision 

problems faced in such systems. 

 In recent years manufacturing and service industries have witnessed several 

developments, as shown by the increase in the number and types of automated systems. 

However, these developments have brought along attendant system design problems. As 

the design problems have grown even more complex, designers and users of automated 

system have had develop new tools to cope with these problems. Manufacturing or 

service system design encompasses several problems. This complex activity involves 

solving a number of designs and planning problems arranged in a hierarchy.  

 Additionally, some of the more important design questions that need to be 

addressed are pre elimination process plan development, determination of tooling and 

fixture requirements, layout of manufacturing cells and machines, material-handling 

devices capable of performing the required material-handling moves. Solving 
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manufacturing cell determination and cell layout problems is generally required for only 

manufacturing systems that produce a large number of components and for which 

manufacturing activities can be divided into almost mutually independent cells (Heragu, 

1997). 

Heragu (1997) mentioned that the location scoring method using subjective decision-

making tool that is relatively easy to use. It consissts of five steps: 

1. List all the factor that are important that have an impact on the location 

decision. 

2. Assign an appropriate weight (typically between 0 and 1) to each factor based 

on the relative importance of each. 

3. Assign a score (typically between 0 and 100) to each location with spect to 

each factor identified in step 1. 

4. Compute the weighted score for each factor for each location by multiplying 

its weight by the corresponding score. 

5. Compute the sum of the weighted scores for each location and choose a 

location based on these scores. 

Several quantitative techniques are available to solve the discrete space, single-

facility location problem. Each is appropriate for a specific set of objectives and 

constraints. For example, the so-called minimax model is appropriate for determining the 

location of an emergency service facility, where the objective is to minimize the 

maximum distance traveled between the facility and any customer. Similiarly, if the 
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objective is to minimize the total distance traveled, the transportation model is 

appropriate (Heragu, 1997). 

2.2.2 Facilities Planning 

Facility layout deals with the selection of the most efficient layout of physical 

departments in a production plant or a service facility in order to operate cost effectively. 

The block layout design seeks the best arrangement of departments based on their 

interrelationships and involves the location of departments within the available area. In 

the design process of the layout many objectives must be considered. Tompkins and 

White (1984) listed the following as typical facilities design objectives: 

1. Support the organization‟s mission through improved handling and control of 

materials. 

2. Effectively utilize people, equipment, space and energy. 

3. Minimize capital investment. 

4. Be flexible and promote ease of maintenance. 

5. Provide for employee safety and job satisfaction 

Space requirements of the departments and the activity relationships among these 

departments are important factors in determining the design of a facility layout. Activity 

relationships influence the location and design of a department. Space requirements 

determine the size of a department and influence the overall design of the layout. The 

facility design process is an iterative process, especially as it relates to determining 

interrelationships among all departments (activities) and space requirements for all 
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activities. Facilities design objectives and activity relationships provide the basis for 

many decisions in the facilities planning process (Dweiri, 1999). 

2.2.3 Activity Relationship Chart 

ARC is based on judgment of experts who decide the relationship between each pair of 

departments in the plant. This decision is vague and usually based on many quantitative 

or qualitative considerations. The flow of materials between departments and the ease of 

supervision of employees in the departments are examples of such vague issues. The 

ratings of these relationships are described in the table below: 

Table 2.1 Closeness Rating table 

Closeness Rating Description 

A Absolutely necessary 

E Especially important 

I Important 

O Ordinary 

U Unimportant 

X Undesirable 

 

Then the closeness ratings are considered analytically in each departments and the 

reason for the assigned rating is indicated using a numeric code. The reasons are 

determined by the designer regardless of their quantitative or qualitative nature (Heragu, 

1997). 
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Department A

Department B

Department C

Department D

Department E

Department F

E

3 I

2

AO 2

I

4

U 4

O

U

U4

2

5

O 5

5

U

I2

I

4

4

U 5

2

O

 
Figure 2.1 Example of ARC 

2.2.4 Material  Handling 

Several definitions are available for material handling. The most comprehensive is the 

one provided by the Material Handling Institute (MHI), which states: “Material handling 

embraces all of the basic operations involved in the movement of bulk, packaged, and 

individual products in a semisolid or a solid state by means of machinery, and within the 

limits of a place of business.” 

 Even a cursory examination of the statement reveals that material handling 

involves much more than just moving the material by using machinery; several additional 

functions are implied in the system. 

 First, material handling involves the movement of material in a horizontal 

(transfer) and a vertical (lifting) direction, as well as the loading and unloading of items. 

Second, specifying that the movement of materials is “within a place of business” implies 

that the movement includes raw materials to work stations, semifinished products 
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between work stations, and removal of the finished products to their storage locations. It 

also distinguishes material handling from transportation; the latter involves moving 

materials from suppliers to places of business or from places of business to customers. 

 Third, the selection of handling equipment is another activity in designed 

material-handling systems. Fourth, the term bulk indicates that the materials are to be 

moved in large, unpackaged volumes such as sand, sawdust, or coal. And fifth, using 

machinery for handling material is the preferred method even though the initial cost 

might be high. The use of human beings on a continuous basis is inefficient and can be 

costly; material-handling equipment soon pays for itself, especially in societies in which 

the cost of labor is high (Sule, 1994). The objectives of material handling can be 

described as follow: 

a. To increase the efficiency of material flow by ensuring the availability of 

materials when and where they are needed. 

b. To reduce material-handling cost. 

c. To improve facilities utilization. 

d. To improve safety and working conditions. 

e. To facilitate the manufacturing process. 

f. To increase productivity. 
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2.2.5 Material  Handling Cost 

The main costs involved in designing and operating a material-handling system are: 

a. Equipment cost, which comprises the purchasing of the equipment and 

auxiliary components, and installation. 

b. Operating cost, which iincludes maintenance, fuel, and labor cost, 

consisting of both wages and injury compensation. 

c. Unit purchase cost, which is associated with purchasing the pallets and 

containers. 

d. Cost due to packaging and damaged material. 

Reducing such cost is one of the primary objectives of a handling systems. There 

are several ways of achieving this goal. For examples, one can minimize the idle time of 

the equipment. High utilization of equipment will eliminate the need to acquire extra 

units. One can be minimize rehandling of material and backtracking, thus reducing 

operating cost. One can arrange closely related departments near each other to result in 

material being moved only short distance. One can precent excessive repairs by planning 

maintenance activities in advance. One should use proper equipment to reduce material 

damage and use unit loads whenever possible. The gravity principle should be used 

whenever possible, since it can reduce operating cost. One should eliminate unsafe 

practices by employees such as lifting heavy items; this will reduce injuries and 

consequent worker compensation. One can minimize the variations in equipment types, 

thus eliminating the need for an inventory of a variety of spare parts and their associated 

costs. One can replace obsolete equipment with new and more efficient ones when the 
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savings justify it. As the reader probably realized by now, we are again applying the 

twenty principles of material handling. 

2.2.6 Fuzzy Logic 

Most of traditional tools for form

- - -

- - -

 and nothing in between. In set theory, an element can either belong 

to set or not; and in optimization, a solution is either feasible or not. Precision assumes 

that the parameters of a model represent exactly either our preception of the phenomenom 

modeled or the features of the real system that has been modeled. Generally precision 

also implies that the model is unequivocal, that is, that it contains no ambiguities. 

 Certainly eventually indicates that we assume the structures and parameters of the 

model to be definitely known, and that there are no doubts about their values or their 

occurence. If the model under consideration is a formal model, that is, if it does not 

pretend to model reality adequately, then the model assumptions are in a sense arbitrary, 

that is, the model builder can freely decide which model characteristics choosen 

(Zimmermann, 1991). 

1. Fuzzy Set Theory 

Dweiri (1999) mentioned that fuzzy set theory was introduced to deal with vague, 

imprecise and uncertain problems. The lack of data is the reason for uncertainty in many 
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daily problems. Fuzzy set theory has been used as a modeling tool for complex systems 

that are hard to define precisely, but can be controlled and operated by humans. 

 Saying that some concept is imprecise and using that imprecision in a model are 

two different things. The bridge between them is the concept of a fuzzy set. To see how 

these properties are used in constructing an actual fuzzy set, consider the concept of 

TALL applied to American males. Given a particular value for an individual‟s height, 

what values are considered tall? In classical set theory, forced to choose an arbitrary 

cutoff point, say, six feet. Since the boundaries between what is in a set and what is 

outside a set are very sharp, these types of constructs are called crisp sets. A characteristic 

function for such a set appears as, 

µTALL = {height ≥ 6}         (2.1) 

Thus anyone over six feet is tall. The membership graph for this set appears in figure 2.2 

TALL
1

0
4 654½ 5½ 6½

Degree

of Membership

µ(x)

Height in feet
 

Figure 2.2 The Crisp Set for the Concept TALL 
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 The discriminant or characteristic function for this set reflects its Boolean nature. 

As we move along the domain, the membership of heights in the set tall remains false 

(zero) until reach exactly six feet when it jumps immediately to true (one). Note that in 

the membership transition graph for crisp sets the line connecting nonmembership and 

membership is dimensionless. All classical or crisp sets have this kind of membership 

function. Although this dischotomization of the sample space may work well for grainy, 

lumpy, and other noncontinuous collections, it generally fails when applied to phenomena 

that have a continuously (and monotonically) changing set of values. 

 The ideal of TALL, illustrated in Figure 2.2, is the classical example of a fuzzy set 

and illustrates the intrinsic properties of fuzzy spaces. The domain of this set, indicated 

along the horizontal axis, is the range of heights between four feet and six and a half feet. 

The degree of membership or truth function is indicated on the vertical axis to the far left. 

In general, the membership goes from zero (non membership) to one (complete 

membership). The membership function and the domain are connected, in this casem by a 

simple linear curve (tallness is directly proportional to height). Now, given a value for 

height, we can determine its degree of membership in the fuzzy set. 
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TALL
1

0
4 654½ 5½ 6½

Degree

of Membership

µ(x)

Height in feet
 

Figure 3.2 Determining the Degree of Membership in TALL 

 

 

 Thus a height of five feet has a [.46] degree of membership. The interpretation of 

this value corresponds to the truth of the proposition. 

  Five feet is TALL 

If the value for height is less than four, it membership is zero. If the height is greater than 

or equal to 6.5 feet, then its membership value is one. This membership function is 

interpreted as a measure of the compatibility between a value from the domain and the 

idea underlying the fuzzy set. In the case of 5 feet, the membership of [.46] means that it 

is moderately but not strongly compatible with the notion of TALL. As the membership 

value moves toward zero the sample becomes less and less compatible with the semantics 

of the fuzzy set and, as the membership value moves toward one, the samples becomes 

more and more compatible with the fuzzy set‟s semantic property. 

 A collection of objects (universe of discourse) U has a fuzzy set A described by a 

membership function µA that takes values in the interval [0, 1], µA: µA: U  [0, 1]. Thus A 

can be represented as:  

 



20 
 

 

A = {( µA (u)/u)| u ϵ  U}            (2.2) 

 

The probability that u belongs to A is the membership function µA(u) 

2. Fuzzy Linguistic Variables 

Linguistic variables take on values that are words in natural language, while numerical 

variables use numbers as values. Since words are usually less precise than numbers, 

linguistic variables provide a method to describe complex systems that are ill-defined in 

traditional quantitative terms.  

A linguistic variable is defined by the name of the variable x and the set term T(x) 

of the linguistic values of x, with each value being a fuzzy number defined on U. For 

example, if temperature is a linguistic variable, then its term set T (temperature) = {high, 

medium, low, . . .}, where each term is characterized by a fuzzy set in a universe of 

discourse U = [0, 100], as shown in Fig. 2.2. The figure show that 70
0
F belongs to the 

linguistic variables {high, medium and low} with membership values of {0.33, 0.67, 0} 

respectively. Using the maximum value to find the fuzzy set that this temperature value 

belongs to, 70
0
F belongs to the fuzzy set medium with a membership value of 0.67 

(Dweiri,1999). 
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Figure 2.4 Membership functions for temperature. 

3. Fuzzy decision-making system 

A fuzzy decision-making system (FDMS) consists of four main components as shown in 

figure below. 

 
Figure 2.5 Basic configuration of fuzzy decision making system (FMDS) 

 The four principal components of the fuzzy decision-making system are: 

a. The fuzzification interface 

Measures the values of the input and output variables, transfers the range 

of these values into a corresponding universe of discourse, and converts 

them into natural language (high, low, very low, etc.). 
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b. The knowledge base 

A database that contains the experts‟ knowledge of the application and the 

control rules of the process. The membership functions are decided by the 

experts based on their knowledge of the system. The fuzzification process 

is defined at this point. 

c. The decision rules 

Simulates the experts‟ decision-making ability based on a fuzzy concept. 

The connective „and‟ is implemented as a fuzzy conjunction in a Cartesian 

product space in which the input variables take in their respective universe 

of discourses. The number of rules used in controlling the system using 

fuzzy control is represented by 

 

K = )             (2.3)  

 

Where: 

K=total number of rules 

m=the number of the sets of rules using one set of variables  

n=the number of input variables used in a set of rules 

L=the number of fuzzy sets in an input variable   

Example of common rules: 

Rule 1: If temperature is high AND lighting is low THEN productivity is 

low 
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Rule 2: If temperature is medium AND lighting is high THEN productivity 

is high 

 

d. Defuzzyfication   

To combine all the related rules for any activity in the layout, we need to 

use a defuzzyfication method. One of the most common methods is the 

center of gravity (COG) method. This method is shown below. 

 

           (2.4)  

 

Where: 

Ro=final crisp rating of the activity 

g=the fuzzy rating of the activity for the rule in consideration 

i=the rules that are used in the activity 

R=the numerical rating of the rule 

m=the membership value of the activity for rule 

2.2.7 CORELAP 

CORELAP is one of the first construction algorithms that was developed and 

“computerized” (Lee and More, 1967). It converts qualitative input data into quantitative 

data and uses this information to determine the first facility to enter the layout. 
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Subsequent facilities then added to the layout, one at time, based on their level of 

interaction with facilities already in the layout. The qualitative flow data are based on the 

relationship chart that uses the codes A, E, I, O, U, and X to describe the adjacency 

requirements for facility pairs. The codes then assigns to numeric values i.e. 6, 5, 4, 3, 2, 

and 1 to the relationship indicators A, E, I, O, U, and X, respecctively.  

 Unlike most other algorithms, which use the distance between the centroids of 

facilities, CORELAP uses the “shortest path” distance measure. The distance between 

any two facilities is equal to the number of unit squares between them (Heragu, 1997). 

 Department selection steps in CORELAP: 

a. The first department placed in the layout is the one with the greatest Total 

Closeness Rating (TRC) value. If there is a tie, then choose the one with 

more A‟s (E‟s, etc.) 

b. If a department has an X relationship with the first one, it is placed last in 

the layout. If a tie exists, choose the one with the smallest TCR value 

c. The second department is the one with an A relationship with the first one 

(or E, I, etc.). If a tie exists, choose the one with the greatest TCR value 

d. If a department has an X relationship with the second one, it is placed next-

to-the-last or last in the layout. If a tie exists, choose the one with the 

smallest TCR value 

e. The third department is the one with most A (E, I, etc.) relationships with 

the already placed departments. If a tie exists, choose the one with the 

greatest TCR value 

f. The procedure continues until all departments have been placed. 
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Table 2.2 Example of Relationship Chart 

Dept A B C D TCR Order 

A   A I U 6 4 

B A   I A 10 1 

C I I   E 7 2 

D U A E   7 3 

A=4 E=3 I=2 O=1 U=0 X=-1 

2.2.8 Computerized Relative Allocation of Facilities Technique (CRAFT) 

CRAFT, which stands for Computerized Relative Allocation of Facilities Technique uses 

the 2-opt solution strategy to develop a layout but has some different implementiations. 

For example, CRAFT does not examine all possible pairwise exchanges before generating 

an improved layout. CRAFT requires the following input data: 

a. Dimensions of the building in which the facilities are to be housed 

b. Dimensions of the facilities 

c. Flow ow material or frequency of trips between facility pairs, and cost per 

unit load per unit distance 

d. An initial layout 

e. Restrictions on the location of facilities, if applicable 

Given the initial layout, CRAFT computes the distance between the centers of 

each facility pair and determines the cost of the initial layout. Note that the cost can be 

computed by determining these items for each pair of facilities: 

a. Product of number of trips between facilities i and j and cost to make one 

trip between the two: and 

b. Distance between facilities i and j. 
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CRAFT considers exchanging the locations of certain pairs of facilities. The 

facility pairs considered either have the same area or are adjacent. If all the facilities are 

of equal area or if every nonadjacent pair of facilities has the same area, then the 

algorithm can examine a maximum of possible exchanges in each iteration with 

expression: 

 

                                                                                                                     (2.5) 

 

Where: 

n=number of facilities in the layout problem 

 In a general facility layout problem, the number of actual exchanges examined 

will be much less because not all facilities will have the same area. The location exchange 

that results in the greatest estimated cost reduction is made. 

 To calculate the estimated cost reduction, CRAFT interchanges the coordinates of 

facilities i and j whose exchange is being considered. If the exchange of facilities i and j is 

being considered, the cost reduction is estimated using this expression: 

 

-  

(2.10) 

 

Where: 

dij=distance between facilities i and j 

fij=flow between facilities i and j 
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2.2.9 WinQSB 

WinQSB is software that can solve several linear program problems, including Facility 

Location and Layout.  The specific capabilities include solve single and multiple 

locations, allow three different distance measures, show location solution in graph, and 

for the line balancing problems. In this paper, WinQSB used to process CRAFT. 

 
Figure 2.6 Display of WinQSB 
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CHAPTER III 

RESEARCH METHODOLOGY 

This chapter will explain the object of the research, building a model requirement of the 

data, which is required in completing the research. The method of data collecting that 

involves field research, tool of analysis data, and framework of research methodology 

will be explained in sub-chapters as below: 

3.1 Research Object 

The study will be conducted at PT. Fumira. This research is focused on the machines 

layout in production department. 

 

3.2 Mathematical Model 

3.2.1 Mathematical Notation 

1. Mathematical Fuzzy Logic 

MF : Number of material flow 

EF : Number of equipment flow 

CR : Closeness rating value 

R : Fuzzy rule 

x : Fuzzy universe of discourse of MF 
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y : Fuzzy universe of discourse of EF  

k : constant value as consequences 

R(r)  : Fuzzy rule in number r 

VL : linguistic variable for very low 

L : linguistic variable for low  

M : linguistic variable for medium 

H : linguistic variable for high 

VH : linguistic variable for very high 

2. CRAFT 

cij : Material-handling cost coefficient involved between location i and j 

fij : Material flow volume between location i and j 

dij : Distance between location i and j 

n : Number of facilities 

The assumptions made in this paper are: 

a. Allowance include input area, output area, space for walk, and temporary 

storage. 

b. In designing the new layout, there are some boundaries like rail road for 

transfer car. 

c. Delivery area is area that inside the department, and it is not reduce the 

area of department itself. 

d. Closeness Rating (CR) for departments that don‟t have relationship 

between them is 2. 
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e. Packaging must be located near the delivery area. 

3.2.2 Fuzzy Logic Model 

The Fuzzy logic model is described as follow: 

1. Define Input and Output Variable 

The input variables that related to the closeness rating in machines layout are number of 

material flow (MF) and equipment flow (EF). The output variable that will be resulted 

from considering the input variables is the closeness rating value (CR).  

2. Fuzzy Set and Membership Function 

Fuzzy set of (MF) and (EF) is shown in figure below. 

VL L M H VH
1

0
a b c d e f

 
Figure 3.1 Representation of (MF) 

 



31 
 

VL L M H VH
1

0
a b c d e f

 
Figure 3.2 Representation of (EF) 

Membership function: 

µA VL (x) =       (3.1) 

  

µA L (x) =                    (3.2) 

µA M (x) =         (3.3) 

µA H (x) =        (3.4) 

µA VH (x) =        (3.5) 
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3. Fuzzy Rule 

The numbers of rules for fuzzy inference system from combination of 2 variables are 25. 

The equation is shown below: 

R(r) = IF MF is x AND EF is y THEN CR = k         (3.6) 

4. Defuzzyfication 

The defuzzyfication step is conduted using the simplest, prevalent and physically 

appealing of all the defuzzyfication method, which is Centroid method. Centre of Gravity 

method is valid for symmetrical output membership functions, but have less 

computationally intensive. The crisp value of the output closeness rating model is: 

 

CR =              (3.7) 

 

X U O I E A

1 2 3 4 5 6
 

Figure 3.3 Representation of (CR) 

3.2.3 CORELAP 

The total closeness rating (TCR) used to determine the sequence of department that will 

be placed, the expression is: 
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                                                                                          (3.8) 

3.3 Data Requirement 

This research uses primary data collected from direct observation in the field. The data is 

focused on the PT. Fumira, especially in production department. The data is described as 

follow: 

1. Initial layout 

2. Department area and allowance 

3. Material handling equipment cost 

4. Material handling equipment type 

5. Material flow between the machines in one shift 

6. Equipment flow between the machines in one shift 

3.4 Data Analysis 

Data analysis is focused to comparing total cost flow in the initial layout with the new 

layout based on CARC that obtained from fuzzy set model. The parameter of optimize 

layout is that the new layout cost flow is lower than initial layout cost flow. 
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3.5 Analysis Tool 

The analysis tool used in data analysis is using Microsoft Excel
® 

to model the layout 

using CORELAP technique. Then the model is optimized with CRAFT using WinQSB
® 

to obtain the minimal total cost flow of the initial and new layout. 

3.6 Research Flow Diagram 

The research steps are described in the figure below: 
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Layout
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Finish

 
Figure 3.3 Research framework 
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CHAPTER IV 

DATA COLLECTING AND DATA PROCESSING 

4.1 Data Collecting 

This research uses primary data collected from direct observation at PT. Fumira focused 

in the production department, taken from production data in Product Handling 

Department in May 2011. More detailed data will be explained in the following sub-

chapter. 

A. Initial Layout 

The initial layout at Finishing Line Department in PT. Fumira is shown in figure below. 
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B

A. Small Coil

B. Auto Shear

C. Forming

D. Corrugation Soft

E. Corrugation Hard

F. Shearing 5

G. Shearing 6

H. Laminating

I. Coil Storage

J. Finished Product 

and Packaging

K. Slitter & Bending

Delivery Area

Transfer Car

D

WH 00 WH 01 WH 02 WH 03

 
Figure 4.1 Initial Layout 

B. Area 

The areas of each machines/departments is shown in table below. The area including 

allowance. 

Table 4.1 Area 

No Name Area(m
2
) 

Location 

Fixed 

A Small Coil 648 No 

B Auto Shear 216 No 

C Forming 2084 No 

D Corrugation Soft 216 No 

E Corrugation Hard 432 No 

F Shearing-5 504 Yes 

G Shearing-6 504 Yes 

H Laminating 360 No 

I Coil Storage 4280 No 

J Packaging 3380 No 

K Slitter&Bending 324 No 

 

Delivery 324 Yes 
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C. Material Handling Equipment Cost 

Material handling cost calculated by the cost that material handling equipment travelled 

per meter. 

Table 4.2 Material Handling Cost 

No Name 
Cost 

(Rp/m) 

1 Crane 50 

2 Forklift 80 

3 
Transfer 

Car 
50 

4 Manual TC 15 

D. Material Handling Equipment Type 

Material Handling Type data show what material handling equipment that used between 

the machines/departments. 

Table 4.3 Material Handling Type 

From To MH Equipment 

Small Coil Packaging C 

Auto Shear Forming C+MTC 

Forming Packaging C 

Corrugation Soft Packaging C+MTC+C 

Corrugation Hard Packaging C+MTC+C 

Shearing-5 

Forming C 

Corrugation 

Soft F/C+TC+C+MTC+C 

Corrugation 

Hard F/C+TC+C+MTC+C 

Packaging F/C+TC+C 

Bending C 

Shearing-6 Corrugation C+MTC+C 
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From To MH Equipment 

Hard 

Packaging F/C+TC+C 

Laminating Forming C 

Coil Storage 

Small Coil F/C+TC+C 

Auto Shear C 

Shearing-5 C 

Shearing-6 C 

Laminating C 

Packaging C 

Slitter & Bending Packaging C 

C=Crane F=Forklift TC=Transfer Car MTC=Manual Transfer Car 

 

E. Material Flow (MF) 

The material flow (MF) is the material that flow between machines/departments in 

piece/shift. The data taken on May 2011. 

Table 4.4 Material Flow 

From To Material Flow 

Small Coil Packaging 1020 

Auto Shear Forming 1832 

Forming Packaging 2276 

Corrugation Soft Packaging 125 

Corrugation Hard Packaging 5000 

Shearing-5 

Forming 2966 

Corrugation 

Soft 1200 

Corrugation 

Hard 14516 

Packaging 6676 

Bending 76 

Shearing-6 

Corrugation 

Hard 18807 

Packaging 9326 

Laminating Forming 444 

Coil Storage 

Small Coil 1020 

Auto Shear 1832 

Shearing-5 25434 

Shearing-6 28133 

Laminating 444 
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From To Material Flow 

Packaging 480 

Slitter & Bending Packaging 76 

 

 

F. Equipment Flow (EF) 

Equipment Flow (EF) is the moving amount of material handling equipment between 

departments in one shift. The data taken on May 2011. 

Table 4.5 Equipment Flow 

From To 
Equipment 

Flow 

Small Coil Packaging 4 

Auto Shear Forming 8 

Forming Packaging 12 

Corrugation Soft Packaging 2 

Corrugation Hard Packaging 14 

Shearing-5 

Forming 7 

Corrugation 

Soft 6 

Corrugation 

Hard 28 

Packaging 17 

Bending 1 

Shearing-6 

Corrugation 

Hard 31 

Packaging 20 

Laminating Forming 2 

Coil Storage 

Small Coil 4 

Auto Shear 4 

Shearing-5 14 

Shearing-6 14 

Laminating 2 

Packaging 3 

Slitter & Bending Packaging 1 
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4.2 Data Processing 

4.2.1 Mathematical and Fuzzy Modeling 

A. Determining the Input and Output Variables 

The input variables to be analyzed are (MF) and (EF) and the output is (CR) which will 

be used to determine the layout design. 

B. Fuzzy Set and the Membership Function 

Fuzzy set for (MF) and (EF) are shown in figures below. 

L M H VH

0 2500 5000 7500 10000

1

500

VL

 
Figure 4.2 Representation of (MF) 

Membership function: 

µA VL (x) =       (4.1) 

  

µA L (x) =                    (4.2) 
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µA M (x) =         (4.3) 

µA H (x) =        (4.4) 

µA VH (x) =         (4.5) 

VL L M H VH
1

0
10 15 20 255

 
Figure 4.3 Representation of (EF) 

Membership function: 

µA VL (x) =       (4.6) 

  

µA L (x) =                    (4.7) 

µA M (x) =         (4.8) 
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µA H (x) =        (4.9) 

µA VH (x) =       (4.10) 

C. Fuzzy Rules 

The numbers of rules for fuzzy inference system from combination of 2 variables are 25. 

The equation is shown below: 

 

R(r) = IF MF is x AND EF is y THEN CR = k       (4.11) 

 

Where: 

R(r)= Rule number r 

MF= Number of material flow 

EF= Number of equipment flow 

CR= Closeness rating value 

x= Fuzzy universe of discourse of MF 

y= Fuzzy universe of discourse of EF  

k= Constant value as consequences 

 Since there are 6 parameters of output (CR), the constant value need to be 

determined based on input range. Table 4.6 below show the constant value in each rule. 
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Table 4.6 Closeness Rating Value 

RULE MF EF CR 

1 VL VL U 

2 VL L U 

3 VL M O 

4 VL H I 

5 VL VH I 

6 L VL U 

7 L L O 

8 L M O 

9 L H I 

10 L VH I 

11 M VL O 

12 M L O 

13 M M I 

14 M H E 

15 M VH E 

16 H VL I 

17 H L I 

18 H M E 

19 H H A 

20 H VH A 

21 VH VL I 

22 VH L I 

23 VH M E 

24 VH H A 

25 VH VH A 

Based on the data collection, there are only 16 rules that necessary. They are 

Rule 1, 2, 3, 6, 7, 8, 11, 12, 13, 14, 18, 19, 22, 23, 24, 25.  

D. Fuzzy Calculation 

There are 20 relationships of departments that have MF and EF between the two 

departments. Each relationships will resulting CR as the output. More detailed data shown 

in Table 4.7:   

 



45 
 

 

 

Table 4.7 Relationship Data Between Departments 

No From To MMFF  EF 

1 Small Coil Packaging 1020 4 

2 Auto Shear Forming 1832 8 

3 Forming Packaging 2276 12 

4 

Corrugation 

Soft Packaging 125 2 

5 

Corrugation 

Hard Packaging 5000 14 

6 Shearing-5 Forming 2966 7 

7 Shearing-5 

Corrugation 

Soft 1200 6 

8 Shearing-5 

Corrugation 

Hard 14516 28 

9 Shearing-5 Packaging 6676 17 

10 Shearing-5 Slitter&Bending 76 1 

11 Shearing-6 

Corrugation 

Hard 18807 31 

12 Shearing-6 Packaging 9326 20 

13 Laminating Forming 444 2 

14 Coil Storage Small Coil 1020 4 

15 Coil Storage Auto Shear 1832 4 

16 Coil Storage Shearing-5 14000 14 

17 Coil Storage Shearing-6 14000 14 

18 Coil Storage Laminating 444 2 

19 Coil Storage Packaging 480 3 

20 Slitter&Bending Packaging 76 1 

 

 The data above then calculated using initial value of each parameter and based on 

fuzzy rules to obtain the CR. The fuzzy calculation is using software MATLAB  FIS 

Editor GUI. Here are the steps:  

1. In FIS Editor Window, determine the input and output. In this case the inputs 

are MF and EF. Add the input by click on Edit->Add variable->Input. 
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Figure 4.4 FIS Editor 

 

2. Click on Edit->Membership Functions, and new window will appear. Edit the 

Membership Functions in each input and output. Determine the range first, 

and then add Membership Function by the number of Membership Function‟s 

needed. Add it by click on Edit->Add MF‟s. If the Membership Function type 

is trapezium, change it in Type column by trapmf type. Then determine the 

parameters in each Membership Function. Repeat the steps until finished. 
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Figure 4.5 Membership Function Editor 

 

3. Click on Edit->Rules to add the Rules. There are 16 rules, the connection is 

AND. Add the rules one by one. 

 
Figure 4.6 Rule Editor 
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4. After all rules have been added, click View->Rules, the new window will 

appear. Input the data into Input column, then the CR will be obtained. 

 
Figure 4.7 Rule Viewer 

 

 Based on summary of fuzzy calculation, CR are obtained. The CR between the 

departments then become Crisp Activity Relationship Chart.  

Table 4.8 Crisp Avtivity Relationship Chart 

Dept A B C D E F G H I J K 

A   2 2 2 2 2 2 2 2 2 2 

B 2   2,58 2 2 2 2 2 2,26 2 2 

C 2 2,58   2 2 2,42 2 2 2 2,83 2 

D 2 2 2   2 2,26 2 2 2 3 2 

E 2 2 2 2   6 6 2 2 3,76 2 

F 2 2 2,42 2,26 6   2 2 4,76 5,05 2 

G 2 2 2 2 6 2   2 4,8 6 2 

H 2 2 2,25 2 2 2 2   2 2 2 

I 2 2,26 2 2 2 4,8 4,8 2,25   2 2 

J 2 2 2,83 2 3,76 5,05 6 2 2   2 

K 2 2 2 2 2 2 2 2 2 2   
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4.2.2 CORELAP 

4.2.2.1 Total Closeness Rating 

Total Closeness Rating (TCR) based on Crisp Activity Relationship Chart shown in table 

below: 

Table 4.9 Total Closeness Rating 

Dept Name TCR Order 

A 
Small Coil 

20 11 

B 
Auto Shear 

20.58 7 

C 
Forming 

21.83 6 

D 
Corrugation Soft 

20.26 8 

E 
Corrugation Hard 29.76 4 

F 
Shearing-5 

30.49 2 

G 
Shearing-6 

30.76 1 

H 
Laminating 

20 10 

I 
Coil Storage 

25.52 5 

J 
Packaging 29.64 3 

K 
Slitter & Bending 

20 9 

4.2.2.2 Placement Sequence  

The placement of the departments in the layout based on TCR  is G-F-J-E-I-C-B-D-K-H-

A. More detailed steps of placement of the departments described as follow : 

 

 

 

 



50 
 

a. Placement Sequence: G-F-J-E-I-C-B-D-K-H-A 

 
Figure 4.8 CORELAP Step 1 

b. Placement Sequence: G-F-J-E-I-C-B-D-K-H-A 

 
Figure 4.9 CORELAP Step 2 
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c. Placement Sequence: G-F-J-E-I-C-B-D-K-H-A 

 
Figure 4.10 CORELAP Step 3 

d. Placement Sequence: G-F-J-E-I-C-B-D-K-H-A 

 
Figure 4.11 CORELAP Step 4 
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e. Placement Sequence: G-F-J-E-I-C-B-D-K-H-A 

 
Figure 4.12 CORELAP Step 5 

 

f. Placement Sequence: G-F-J-E-I-C-B-D-K-H-A 

 
Figure 4.13 CORELAP Step 6 
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g. Placement Sequence: G-F-J-E-I-C-B-D-K-H-A 

 
Figure 4.14 CORELAP Step 7 

h. Placement Sequence: G-F-J-E-I-C-B-D-K-H-A 

 
Figure 4.15 CORELAP Final Step 
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4.2.3 CRAFT 

4.2.3.1 Material Handling Cost 

Material handling cost between departments must be known to calculate the flow cost of 

the layout. Material handling cost obtained from Equipment Flow (EF) times by material 

handling equipment cost. Table 4.11 and 4.12 below show the material handling cost per 

shift.  

Table 4.10 Material Handling Cost 

From To 
Materia

l Flow 

Equipmen

t Flow 
MH Equipment 

MH 

Cost 

(Rp/m) 

MH 

Cost 

Small Coil Packaging 1020 4 C 50 200 

Auto Shear Forming 1832 8 C+MTC 65 520 

Forming Packaging 2276 12 C 50 600 

Corrugation Soft Packaging 125 2 C+MTC+C 32,5 65 

Corrugation 

Hard Packaging 5000 14 C+MTC+C 32,5 455 

Shearing-5 

Forming 2966 7 C 50 350 

Corrugation Soft 1200 6 

F/C+TC+C+MTC+

C 80 480 

Corrugation 

Hard 14516 28 

F/C+TC+C+MTC+

C 80 2240 

Packaging 6676 17 F/C+TC+C 80 1360 

Bending 76 1 C 50 50 

Shearing-6 

Corrugation 

Hard 18807 31 C+MTC+C 

38,333

3 

1188,33

2 

Packaging 9326 20 F/C+TC+C 80 1600 

Laminating Forming 444 2 C 50 100 

Coil Storage 

Small Coil 1020 4 F/C+TC+C 80 320 

Auto Shear 1832 4 C 50 200 

Shearing-5 25434 14 C 50 700 

Shearing-6 28133 14 C 50 700 

Laminating 444 2 C 50 100 

Packaging 480 3 C 50 150 

Slitter & 

Bending Packaging 76 1 C 50 50 
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Table 4.11 Matrix of Material Handling Cost 

    
T
o 

Sma
ll 
Coil 

Auto 
Shea
r 

Formin
g 

Corrugati
on Soft 

Corrugati
on Hard 

Shearin
g-5 

Shearin
g-6 

Laminati
ng 

Coil 
Storag
e 

Packagi
ng 

Slitter&Bendi
ng 

      A B C D E F G H I J K 

From                           

Small Coil A                     200   

Auto Shear B       520                 

Forming C                     600   

Corrugation 
Soft D                     65   

Corrugation 
Hard E                     455   

Shearing-5 F       350 480 2240         1360 50 

Shearing-6 G           1188,332         1600   

Laminating H       100                 

Coil Storage I   320 200       700 700 100   150   

Packaging J                         

Slitter&Bendin
g K                     50   
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4.2.3.2 Cell Layout 

From the initial layout developed by CORELAP, it must be converted into cell layout 

using Microsoft Excel to determine the coordinate of each departments. Each cell is 

represented of 6m x 6m area. Figure below show the cell layout based on initial layout: 

 
Figure 4.16 CORELAP Initial Cell Layout  

 From the initial cell layout developed using CORELAP, the coordinate of each 

departments can be determined. Table 4.12 below the coordinate of each deparments. 

Table 4.12 Coordinates 

Department Name Area (m2) Coordinate 

A Small Coil 
648 

(1,18)-(6,20) 

B Auto Shear 
216 

(7,8)-(9,9) 

C Forming 
2084 

(1,1)-(8,7),(9,6)-(9,7) 

D Corrugation Soft 
216 

(10,6)-(11,8) 

E Corrugation Hard 
432 

(12,8)-(13,13) 

F Shearing-5 
504 

(12,6)-(18,7) 
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Department Name Area (m2) Coordinate 

G Shearing-6 
504 

(10,14)-(16,15) 

H Laminating 
360 

(10,9)-(11,13) 

I Coil Storage 
4280 

(9,1)-(21,5),(19,6)-(21,7),(14,8)-(21,13) 

J Packaging 
3380 

(1,8)-(6,17),(7,13)-(9,20),(17,14)-(21,15) 

K Slitter & Bending 
324 

(7,10)-(9,12) 

4.2.3.3 CRAFT Process 

CRAFT process use software WinQSB® to ease the switches of departments and 

calculate the flow cost of the layout. The method used in this CRAFT is exchange 

between 2 departments. In analyse the improved layout, it must be considered the 

feasibility of the layout itself. More detailed steps of WinQSB will be explained below: 

1. Preparation 

This step is the preparation before the CRAFT process can be ran, the 

project type is Functional Layout and the objective is minimization. The 

input are project name, number of departments, number of rows, and 

number of columns.  

  Fill the project name, number of departments is 11, number of rows 

and columns based on initial cell layout developed using CORELAP are 20 

and 21 respectively. Because the objective of this paper is to minimize the 

flow cost, choose minimization in objective criterion. 
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Figure 4.17 Problem Specification 

 

2. Data Input 

The data input in this step are department name, fixed location, flow cost, 

and the coordinate of departments. The department that have fixed location 

are department F (Shearing-5) and department G (Shearing-6), change the 

fixed location row of those two departments with Yes. Copy the material 

handling cost matrix into flow cost columns, and copy the coordinates in 

the Cell Locations. 

 
Figure 4.18 Data Input 

 

3. Solve and Analyze 

Make sure that the data inputted correctly, the click Slove and Analyze in 

the main menu window and choose Solve the Problem. 
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Figure 4.19Solve and Analyze 

  In Functional Layout Solution window, choose Improve by 

Exchanging 2 departments, Rectilinear Distance for Distance Measure 

and check Show the Exchange Iteration. Then, the CRAFT will 

estimate the layout change using this expression: 

 

-

        (4.12) 

 

Where dij and fij refer to the distance and flow between facilities i and 

j, respectively.  

 
Figure 4.20 Functional Layout Solution 
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4. Output 

The CRAFT process in exchanging 2 departments resulted 8 iterations of 

new layout, and also calculated the total flow cost from each layout. Each 

iteration must be analyzed whether its layout feasible or not. Then the final 

layout cost flow compared to initial layout.  

Figures below show the layout and total cost flow from initial layout 

until last iterations: 

a. Initial Layout 

 
Figure 4.21 Initial Layout 
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b. Initial Layout developed using CORELAP 

 
Figure 4.22 Initial Layout developed using CORELAP 

c. First and Second Iteration 

 
Figure 4.23 First Iteration (left) and Second Iteration (right) 
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d. Third and Fourth Iteration 

 
Figure 4.24 Third Iteration (left) and Fourth Iteration (right) 

 

e. Fifth and Sixth Iteration 

 
Figure 4.25 Fifth Iteration (left) and Sixth Iteration (right) 
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f. Seventh Iteration 

 
Figure 4.26 Seventh Iteration  

 

 Based on the iterations analysis and assumption, the CRAFT exchange between 

departments are not feasible from the first iteration, so it is means that the layout 

developed by CORELAP technique already good. 
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Figure 4.27 Final Layout 

 

 
Figure 4.28 Final Layout Cost Flow 
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 From the figures above, the layout design can be draw. Note that some supporting 

facilities also changed following the layout changes. In this case, the transfer car that 

located in the area of Corrugating moved into the new location of Corrugating. 

I

J

WH 00 WH 01 WH 02 WH 03

G

H

F

J

J

A. Small Coil

B. Auto Shear

C. Forming

D. Corrugation Soft

E. Corrugation Hard

F. Shearing 5

G. Shearing 6

H. Laminating

I. Coil Storage

J. Finished Product 

and Packaging

K. Slitter & Bending

Delivery Area

Transfer Car

E

D

C

A

KB

 
Figure 4.29 Final Layout 

4.3 Summary 

As seen on Figure 4.28, the total cost flow is Rp 5.445.193,00 per shift, reduced from Rp 

Rp 9.624.068,00 total cost flow in Initial Layout (Figure 4.16). The CRAFT processes are 

not feasible, so it the most optimal layout is in the final CORELAP layout.  
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CHAPTER V 

DISCUSSION 

As mentioned before, facility layout planning is important things in manufacture. Mostly, 

material handling is the main factor that affects the cost in facility layout. The material 

handling cost itself can be reduced by developing the new layout based on Crisp Activity 

Relationship Chart (CARC). As the purpose of this research, total cost flow of new 

developed layout reduced to 43%. 

 Fuzzy logic used to determine the amount for CARC based on variables and fuzzy 

rule. The variables used in this paper are Material Flow (MF) and Equipment Flow (EF). 

CARC resulted various amount between departments that have relationship that used to 

the next process. CARC used to develop the new layout using CORELAP algorithm, 

using the Total Closeness Rating then from the final CORELAP layout, it optimized 

using CRAFT. Besides that, CRAFT also used to obtain the total flow cost the layout. 

The new developed layout switch some departments that have no fixed position and have 

similar areas into more profitable location. The switched departments also consider some 

factors and still need to be analyzed whether it is feasible or not.     
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5.1 Fuzzy Modeling 

In fuzzy modeling there are two inputs to be analyzed, which are Material Flow (MF) and 

Equipment Flow (EF), and the output is Closeness Rating (CR) which later used to create 

CARC. The fuzzy itself using Mamdani model. Based on combination of linguistic 

variables in each input, the number of fuzzy rule is 25. The fuzzy rules reduced from 25 

rules in to 16 rules, based on the data collection the other 9 rules are not suit the data. 

Fuzzy rule can effect the output or not, it based on membership value in each rule. The 

membership value is between 0 and 1, the bigger membership value, the bigger effect of 

the rule to the output. Otherwise, membership value 0 is mean that the rule does not have 

any effect to the output. The 25 membership value then center-weighted using Center of 

Gravity method to obtain the crisp output, which is CR. In this research, there are 20 

inputs that have relationship between departments and have both MF and EF. 

5.2 CORELAP   

CORELAP process start after the CARC obtained by fuzzy logic. CARC resulted Total 

Closeness Rating (TCR) which used to determine the sequence of department placement 

in CORELAP process. The sequence is : G-F-J-E-I-C-B-D-K-H-A (Shearing-5 and 

Shearing 6, beside it has bigger TCR, it also fixed location, then Packaging, Corrugation 

Hard, Coil Storage, Forming, Auto Shear, Corrugation Soft, Slitter & Bending, 

Laminating, and Small Coil respectively.  
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Calculated using WinQSB®, the total cost flow of material handling itself reduced 

to Rp 5. 445.193,00 from Rp 9.624.068,00 total cost flow in initial layout. Figure 5.1 

show the final layout developed by CORELAP.  

 
Figure 5.1 CORELAP Final Layout 

5.3 CRAFT 

To maximize the layout, CRAFT ran using software WinQSB®. In this research, CRAFT 

resulted 8 iterations of switched department, but still need to be analyzed. CRAFT also 

used to obtain the total flow cost of the layout. From the first iteration of the CRAFT 

process, it is not feasible anymore, because the departments of Packaging and Coil 

Storage are switched, but the Packaging area should near the Delivery area, which is 

located mainly in the top of the layout. Also in the next iterations, the Corrugation Soft 

switched into the bottom left of the layout, which is too far away from other production 

area.  

 



69 
 

I

J

WH 00 WH 01 WH 02 WH 03

G

H

F

J

J

A. Small Coil

B. Auto Shear

C. Forming

D. Corrugation Soft

E. Corrugation Hard

F. Shearing 5

G. Shearing 6

H. Laminating

I. Coil Storage

J. Finished Product 

and Packaging

K. Slitter & Bending

Delivery Area

Transfer Car

E

D

C

A

KB

 
Figure 5.2 Final Layout 
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CHAPTER VI 

DISCUSSION 

6.1 Conclusion 

The conclusion of this research can be established as follow: 

a. Crisp Activity Relationship Chart (CARC) has resulted more optimize 

layout rather than traditional Activity Relationship Chart. To obtain CARC, 

fuzzy logic used to resulted crisp output which is Closeness Rating (CR) 

based on two inputs Material Flow (MF) and Equipment Flow (EF), and 

also fuzzy rule. According to CARC, new layout can be developed using 

CORELAP algorithm and CRAFT to optimize the layout. 

b. The material handling cost in new developed layout is Rp 5. 445.193,00  per 

shift, reduced from Rp 9.624.068,00 per shift in initial layout. The optimize 

layout can be seen on Figure 5.2 in chapter five. 

6.2 Recommendation 

Some recommendations in this research described as follow: 

a. According to the result of this research, company can consider this layout to 

reduce the cost in manufacturing their product. Moreover, using this fuzzy 
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logic to determine the CARC is more objective rather than traditional ARC, 

and resulted more minimize material handling cost. 

b. Further research can implement this method to developing new layout, or 

maximize the recent layout by minimize the material handling cost. Beside 

MF and EF, more inputs can be considered. ALDEP algorithm also can be 

implemented, except of CORELAP. 
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